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A 

Aboriginal > Autochtone (Employment Equity Act)   

Abuse of authority > Abus de pouvoir (Public Service Employment Act)  

Access > Accessibilité (Public Service Employment Act)  

Access talent > Accéder au talent  

Accommodation > Mesures d’adaptation (Canadian Human Rights Act)  

Acting appointment > Nomination intérimaire (Public Service Employment Act and 
Treasury Board of Canada Secretariat)  

Acting pay > Rémunération d’intérim (Treasury Board of Canada Secretariat)  

Active case > Dossier actif (TERMIUM Plus®)  

Active workstation > Poste de travail actif  

Adverse impact > Effet défavorable / effet négatif / effet néfaste  

Advertised appointment process > Processus de nomination annoncé  
(Public Service Employment Act, TERMIUM Plus® and the Human Resources 
Management Glossary, Translation Bureau)  

Advice and guidance > Avis et conseils  

Affirmation of Aboriginal Affiliation Form > Formulaire d’affirmation d’affiliation 
autochtone (TERMIUM Plus®) 

Agency > Organisme (Public Service Employment Act and TERMIUM Plus®)  

Ahead of other candidates > Avant tout autre candidat  

Allegation of improper political activity > Allégation d’activités politiques irrégulières 
(TERMIUM Plus®and the Human Resources Management Glossary, Translation 
Bureau)  

Anonymized file > Fichier anonymisé 

Anonymized Recruitment Pilot Project > Projet-pilote sur le recrutement anonyme 

Anticipatory staffing > Dotation anticipée  
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Applicant data > Données sur les postulants  

Applicant from an inventory > Postulant issu d’un répertoire  

Appointment > Nomination (Public Service Employment Act and TERMIUM Plus®)  

Appointment decision > Décision de nomination 

Appointment Delegation and Accountability Instrument > Instrument de délégation 
et de responsabilisation en matière de nomination 
 
Appointment framework > Cadre de nomination (TERMIUM Plus®)  

Appointments of persons to and from within the public service > Nominations de 
personnes appartenant ou non à la fonction publique  

Appointment Policy > Politique de nomination (TERMIUM Plus®and the Human 
Resources Management Glossary, Translation Bureau)  

Appointment process > Processus de nomination (Public Service Employment Act)  

Appointment-related responsibilities > Responsabilités liées aux nominations  

Appointment to the Executive Group > Nomination au groupe de la direction  

Appointment to the public service > Nomination à la fonction publique (Public Service 
Employment Act)  

Appointments to and within the public service > Nominations à la fonction publique 
et au sein de celle-ci (Public Service Employment Act)  

Appointments to term or indeterminate status through non-advertised 
processes > Nominations pour une durée déterminée ou indéterminée découlant de 
processus non annoncés  

Area of management > Composante de gestion (Treasury Board of Canada 
Secretariat and TERMIUM Plus®)  

Area of recourse > Zone de recours (Public Service Employment Act)  

Area of selection > Zone de sélection (Public Service Employment Act)  

Articulation > Formulation  

Aspiring leader > Aspirant-cadre  
 
Assessment accommodation > Mesures d’adaptation en matière d’évaluation 
(Canadian Human Rights Act)  

Assessment Board > Comité d’évaluation  
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Assessment Centre Integrated Information System > Système d’information intégré 
des centres d’évaluation  

Assessment requirement > Exigence relative à l’évaluation  

Asset qualifications > Qualifications constituant un atout (TERMIUM Plus®and the 
Human Resources Management Glossary, Translation Bureau)  

Assignment > Affectation  

Attract talent > Attirer le talent 

Audit > Vérification  

Audit approach > Stratégie de vérification (TERMIUM Plus®)  

Audit sample > Échantillon de vérification (TERMIUM Plus®)  

Audit scope > Portée de la vérification  

Auto-clearance > Autorisation automatique 
 
Awareness and outreach > Sensibilisation et communication  

B 
Bad faith > Mauvaise foi  

Bargaining agent > Agent négociateur (TERMIUM Plus®and Treasury Board of 
Canada Secretariat)  

Barrier > Obstacle (TERMIUM Plus®)  

Bias > Partialité (TERMIUM Plus®)  

Bilingual imperative appointment > Nomination bilingue impérative 
(TERMIUM Plus®)  

Bilingual position > Poste bilingue  

Business transformation > Transformation des activités  

Business transformation team > Équipe de transformation des activités  



Public Service Commission – 2019 Lexicon   

 
 

C 
Canada.ca Content Style Guide > Guide de rédaction du contenu du site Canada.ca 
(Treasury Board of Canada Secretariat)  

Canadian Heritage > Patrimoine canadien  

Career stream > Répertoire de carrières  

Case closed > Dossier clos  

Case completed > Dossier traité  

Case summary > Résumé de cas  

Casual employee > Employé occasionnel (Public Service Employment Act)  

Casual employment > Emploi occasionnel  

Central index > Fichier central (Public Service Employment Act and TERMIUM Plus®)  

Central Repository of Active Federal Public Service Pools > Répertoire central de 
bassins actifs au sein de la fonction publique fédérale (GCconnex)  

Checklist > Liste de vérification  

Chief Financial Officer > Dirigeant principal des finances  

Collective staffing > Dotation collective (TERMIUM Plus® and the Human Resources 
Management Glossary, Translation Bureau)  

Collective staffing process > Processus de dotation collective (TERMIUM Plus® and 
the Human Resources Management Glossary, Translation Bureau)  

Compliance > Conformité  

Concept case > Analyse de concept (Enterprise Architecture Review Board, Treasury 
Board of Canada Secretariat)  

Conditional offer of appointment > Offre de nomination conditionnelle  

Condition of appointment > Condition de nomination (TERMIUM Plus®)  

Conditions of employment > Conditions d’emploi (Public Service Employment Act)  

Continuous learning > Apprentissage continu (TERMIUM Plus®)  
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Continuous service > Service continu (Treasury Board of Canada Secretariat)  

Corporate Affairs Sector > Secteur des affaires ministérielles 

Corporate Secretariat > Secrétariat aux affaires générales (Public Service 
Commission of Canada)  

Corrective action > Mesure corrective (Public Service Employment Act)  

Cost recovery > Recouvrement des coûts (TERMIUM Plus®)  

Counselling and coaching services > Services de counselling et d’encadrement 
(TERMIUM Plus®)  

Critical skills gaps > Pénurie de compétences essentielles  

Cyclical assessment > Évaluation cyclique  

Cyclical monitoring > Surveillance cyclique  

D 
Decision-maker > Décisionnaire (TERMIUM Plus® and Glossary on values and ethics, 
Translation Bureau)  

Deficiency > Lacune  

Delegated manager > Gestionnaire délégué (TERMIUM Plus® and the Human 
Resources Management Glossary, Translation Bureau)  

Delegated organization > Organisation déléguée  

Delegation > Délégation (Public Service Employment Act)  

Departments and agencies > Ministères et organismes  

Deployment > Mutation (Public Service Employment Act)  

Deputy head > Administrateur général (TERMIUM Plus® and the Human Resources 
Management Glossary, Translation Bureau)  

Designated group > Groupe désigné (Employment Equity Act)  

Designated Political Activities Representative > Représentant désigné en matière 
d’activités politiques  
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Deviation rate > Taux de déviation  

Disclosure summary (Investigations) > Résumé non anonyme (enquêtes)  

Discontinued case > Dossier discontinué  

Discrepancy > Divergence  

Dismiss > Destituer  

Displaced employee > Employé déplacé  

Duly delegated manager > Gestionnaire délégué dûment autorisé  

Duty of loyalty > Obligation de loyauté (Treasury Board of Canada Secretariat)  

Duty to accommodate > Obligation de prendre des mesures d’adaptation  
(Treasury Board of Canada Secretariat)  

E 
Early intervention > Intervention précoce (TERMIUM Plus® and the Human Resources 
Management Glossary, Translation Bureau)  

Election period > Période électorale  

Emerging Leaders Network > Réseau des leaders émergents 

Employability skills > Aptitudes à l’emploi  

Employee > Fonctionnaire (under the Public Service Employment Act)  

Employee engagement > Mobilisation du personnel (Translation Bureau)  

Employee engagement strategy > Stratégie de mobilisation du personnel (Translation 
Bureau)  

Employee movements within the public service > Déplacements des fonctionnaires 
au sein de la fonction publique  

Employer > Employeur (Public Service Employment Act)  

Employment Equity Act > Loi sur l’équité en matière d’emploi  

Employment equity designated group > Groupe visé par l’équité en matière d’emploi 
(Treasury Board of Canada Secretariat and TERMIUM Plus®)  
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Employment equity lens > Perspective d’équité en matière d’emploi  

Employment equity program > Programme d’équité en matière d’emploi (Employment 
Equity Act)  

Engagement process > Processus de mobilisation  

Enhanced Integration Project > Projet d’amélioration de l’intégration  

Enterprise Architecture Review Board > Conseil d’examen de l’architecture intégrée 
(Treasury Board of Canada Secretariat)  

Entry-level officer position > Poste d’agent au niveau d’entrée (TERMIUM Plus®)  

Entry-level recruitment > Recrutement au niveau d’entrée (TERMIUM Plus®)  

Environmental scan > Analyse du contexte / analyse de la conjoncture 
(TERMIUM Plus®)  

Essential qualification > Qualification essentielle (Public Service Employment Act)  

Essentially assessed pool > Bassin de candidats évalués au regard des qualifications 
essentielles (Translation Bureau)  

E-staffing > Dotation électronique 

E-testing > Examen en ligne / test en ligne  

E-testing capacity > Capacité en matière d’examens en ligne  

E-testing centre > Centre d’examens en ligne  

Executive appointment > Nomination au groupe EX (TERMIUM Plus®)  

Executive consultant > Consultant-cadre 

EX-equivalent level > Niveau équivalent EX  

Exclusion Approval Order > Décret d’exemption (Treasury Board of Canada 
Secretariat and TERMIUM Plus®)  

Executive counselling and coaching services > Services de counselling et 
d’encadrement aux cadres supérieurs (Translation Bureau)  

Executive counselling services > Services de counselling aux cadres  

Executive Group > Groupe de la direction (TERMIUM Plus®)  

Exhibit > Pièce / pièce justificative / document justificatif  
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External advertised appointment process > Processus de nomination externe 
annoncé  

External and internal recruitment > Recrutement externe et interne (TERMIUM Plus®)  

External appointment process > Processus de nomination externe (Public Service 
Employment Act)  

External hiring > Embauche externe (TERMIUM Plus®)  

External recruitment > Recrutement externe (TERMIUM Plus®)  

F 
Fair > Équitable  

Fairly > De manière équitable  

Favouritism > Favoritisme (TERMIUM Plus®)  

Fairness > Justice (value) / équité (general context)  

Federal election > Élection fédérale  

Federal Intership for new comers > Programme fédéral de stages pour les nouveaux 
arrivants  

Federal Student Work Experience Program > Programme fédéral d’expérience de 
travail étudiant  

First line of oversight > Premier mode de surveillance (Translation Bureau)  

First official language > Première langue officielle  

Fiscal year > Exercice financier / exercice  

Follow-up audit > Vérification de suivi  

Founded allegation > Allégation fondée (TERMIUM Plus®)  

Founded complaint > Plainte fondée (TERMIUM Plus®)  

Fraud > Fraude (TERMIUM Plus®)  

Fraud case > Cas de fraude (Public Service Employment Act)  

Full authority > Pleins pouvoirs  
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Fully assessed pool > Bassin de candidats entièrement évalués  

Functional community > Collectivité fonctionnelle  

G 
GC Jobs > Emplois GC 

GC Jobs Transformation > Transformation Emplois GC 

General public opportunity > Poste ouvert au public  

Geographic criterion > Critère géographique  

Government-wide audit > Vérification pangouvernementale 

Graduates program > Programme des diplômés  

Guidance / Guidelines > Guides d’orientation  

Guidance document > Document d’orientation (TERMIUM Plus®)  

H 
Health of the staffing system > État du système de dotation  

Hiring > Embauche  

Hiring activities > Activités d’embauche  

Hiring and staffing activities to and within the public service > Activités 
d’embauche externe et de dotation interne à la fonction publique  

Hiring of former students > Embauche d’anciens étudiants (PSC website)  

Human resources advisor > Conseiller en ressources humaines (TERMIUM Plus®)  

Human resources authority > Pouvoirs en matière de ressources humaines  

Human resources planning > Planification des ressources humaines 
(TERMIUM Plus®)  
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Human resources professional > Professionnel des ressources humaines 
(TERMIUM Plus®)  

Human resources specialist > Spécialiste en ressources humaines (TERMIUM Plus®)  

Human resources staff > Personnel des ressources humaines  

I 
Improper conduct > Conduite irrégulière (Public Service Employment Act)  

Improper political activity > Activités politiques irrégulières  

In-basket exercise > Exercice in-basket (TERMIUM Plus®)  

Incumbent-based process > Processus fondé sur les qualités du titulaire  
(Public Service Employment Regulations and TERMIUM Plus®)  

Indeterminate appointment > Nomination pour une période indéterminée 
(TERMIUM Plus®)  

Indeterminate employee > Employé nommé pour une période indéterminée 

Indeterminate employment > Emploi pour une période indéterminée (Public Service 
Employment Act)  

Indicator > Indicateur  

Indeterminate workforce > Effectif pour une période indéterminée  

Indigenous Centre of Excellence > Centre d’excellence autochtone  

Indigenous Peoples > Peuples autochtones (Prime Minister’s Office)  

Individual’s strengths > Points forts de la personne  

Inflow (new employees) > Arrivées (nouveau employés) 

Informal discussion > Discussion informelle (Public Service Employment Act)  

Information regarding acting appointment > Avis de nomination intérimaire 
(TERMIUM Plus® and jobs.gc.ca)  

Information session > Séance d’information (TERMIUM Plus®)  

Informed decision > Décision éclairée (TERMIUM Plus®)  
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Integrated human resources plan > Plan intégré des ressources humaines  

Integrated human resources planning > Planification intégrée des ressources 
humaines  

Integrity of staffing > Intégrité du processus de dotation  

Interdepartmental > Interministériel  

Interorganizational > Interorganisationnel  

Internal appointment process > Processus de nomination interne  

Invalidation of test results > Invalidation des résultats de test  

Inventory > Répertoire (TERMIUM Plus®)  

Investigation report > Rapport d’enquête (TERMIUM Plus®)  

Involuntary displacements > Déplacements involontaires  

J 
Job fair > Salon de l’emploi (TERMIUM Plus®)  

 

K 
Key decision point > Point de décision clé  

Key leadership competencies > Compétences clés en leadership  

Key leadership competencies profile > Profil de compétences clés en leadership  

Key success factor > Facteur clé de réussite  
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L 
Language requirements > Exigences linguistiques (TERMIUM Plus®)  

Language training plan > Plan de formation linguistique  

Lateral and downward movements > Déplacements latéraux et régressifs  

Lay-off > Mise en disponibilité (Public Service Employment Act)  

Leave without pay > Congé sans solde (Public Service Employment Act)  

Legal obligation > Obligation légale (TERMIUM Plus®)  

Legal rights and responsibilities > Responsabilités et droits légaux  

Legal Services > Services juridiques  

Legislative framework > Cadre législatif (TERMIUM Plus®)  

Legislative, regulatory and policy requirements > Exigences de la loi, des 
règlements et des politiques  

Level check of second official language > Indicateur du niveau de compétence dans 
la seconde langue officielle  

Lifeline provision > Droit résiduel  

Limited access > Accès restreint (TERMIUM Plus®)  

Linguistic duality > Dualité linguistique  

M 
Mandatory Appointment Policy > Politique obligatoire en matière de nomination  

Mandatory policy > Politique obligatoire  

Match rates > Taux d’appariement / taux de concordance / taux de correspondance 
(TERMIUM Plus®)  
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Maturation of the staffing system > Évolution du système de dotation (Translation 
Bureau)  

Member of a visible minority > Membre d’une minorité visible (TERMIUM Plus®)  

Memorandum of Understanding > Protocole d’entente (TERMIUM Plus®)  

Merit > Mérite (principe du) [Public Service Employment Act]  

Merit criteria > Critères de mérite  

Merit demonstrated > Respect du mérite démontré (Translation Bureau)  

Merit met > Mérite respecté  

Merit not met > Mérite non respecté  

Merit not demonstrated > Respect du mérite non démontré  

Methodology > Méthode / méthodologie (TERMIUM Plus®)  

Micro organization > Micro-organisation  

Mobility provision for former ministers’ staff > Disposition concernant la mobilité des 
anciens membres du personnel des cabinets de ministres (Public Service Employment 
Act)  

Mobility provision for persons formerly employed in an excluded position at the 
Office of the Governor General’s Secretary > Disposition concernant la mobilité des 
personnes ayant occupé un poste exclu au Bureau du secrétaire du gouverneur général 
(Office of the Governor General’s Secretary Employment Regulations)  

Monitoring > Surveillance  

Movements of indeterminate employees > Déplacements des fonctionnaires 
nommés pour une période indéterminée  

Movement within (Tables and figures) > Mobilité interne  

Municipal election > Élection municipale  
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N 
 

National area of selection > Zone nationale de sélection  

New Direction in Staffing > Nouvelle orientation en dotation (Translation Bureau)  

New Direction in Staffing interface > Interface de la Nouvelle orientation en dotation  

New indeterminate employees > Nouveaux fonctionnaires nommés pour une période 
indéterminée  

New indeterminate hires / hiring > Recrues nommées pour une période indéterminée  

Next Generation HR and Pay System > Système de RH et de paye de la prochaine 
génération (Treasury Board of Canada Secretariat) 
 
Non-advertised appointment process > Processus de nomination non annoncé  

Non-compliance > Non-conformité  

Non-EX > N’appartenant pas au groupe EX 

Non-Ex Group appointments > Nominations à des postes autres que le groupe EX  

Non-EX position > Poste autre que EX (TERMIUM Plus®)  

Non-imperative appointment > Nomination non impérative (Public Service 
Employment Act)  

Non-partisanship > Impartialité politique  

Non-partisanship Program > Programme d’impartialité politique  

Notification > Notification  

O 
Oath or solemn affirmation > Serment ou affirmation solennelle  

Occupational category > Catégorie professionnelle (Public Service Employment Act, 
TERMIUM Plus® and Treasury Board of Canada Secretariat)  
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Occupational group > Groupe professionnel  

Offer of appointment > Offre de nomination  

Office of Primary Interest > Bureau de première responsabilité 

Office of the Governor General’s Secretary > Bureau du secrétaire du gouverneur 
général (Public Service Employment Act)  

Officer-level position > Poste d’agent (TERMIUM Plus®)  

Ombudsman’s Office > Bureau de l’ombudsman 

Onboard new employee > Intégrer un nouvel employé  

Onboarding > Intégration  

Ongoing monitoring > Surveillance continue 

Online testing > Examen en ligne / test en ligne  

Online testing facility > Fonctionnalité de tests en ligne  

Operational requirement > Exigence opérationnelle  

Organizational human resources support > Soutien organisationnel en matière de 
ressources humaines  

Organizational need > Besoin organisationnel  

Organizational results framework > Cadre organisationnel sur les résultats  

Organizational staffing priorities > Priorités organisationnelles en matière de dotation 
(TERMIUM Plus®)  

Organizational staffing strategy > Stratégie organisationnelle en matière de dotation 
(TERMIUM Plus®)  

Organization > Organisation  

Outcome > Résultat  

Outflow > Départs  

Output > Extrant  

Outreach > Activités de communication / activités de liaison / activités de rayonnement 
(according to the context)  

Outreach calendar > Calendrier des activités de liaison  

Outreach initiative > Initiative de liaison  
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Outreach process > Stratégie de liaison  

Oversight > Surveillance / contrôle  

Oversight and Investigations Sector > Secteur de la surveillance et des enquêtes 

P 
Panel discussion > Discussion en groupe / Discussion entre experts  
(according to the context) [TERMIUM Plus®]  
 
Partially assessed pool > Bassin de candidats partiellement évalués  

Part-time employee > Fonctionnaire à temps partiel  

Part-time worker > Travailleur à temps partiel  

Pass mark > Note de passage  

Personal favouritism > Favoritisme personnel  

Person to be notified > Personne à notifier (Public Service Employment Act)  

Person with a disability > Personne handicapée (TERMIUM Plus®)  

Person with a priority entitlement > Bénéficiaire de priorité  

Placement > Placement (TERMIUM Plus®)  

Policy > Politique  

Plain language > Langage clair et simple (Treasury Board of Canada Secretariat)  

Policy and oversight frameworks > Cadres de politiques et de surveillance 
(Translation Bureau)  

Policy and Communications Sector > Secteur des politiques et des communications  

Policy framework > Cadre des politiques  

Policy position > Position politique / position de principe 

Policy research > Recherches en politiques 

Policy setting function > Fonction d’établissement des politiques  

Political Activities Regulations > Règlement concernant les activités politiques 
(Public Service Employment Act)  
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Political activity > Activité politique (Public Service Employment Act)  

Political activity provisions of the Public Service Employment Act > Dispositions 
de la Loi sur l’emploi dans la fonction publique liées aux activités politiques 

Political candidate > Candidat politique  

Political influence > Influence politique (Public Service Employment Act)  

Political party > Parti politique  

Pool (of candidates) > Bassin (de candidats)  

Pool management guide > Guide de gestion des bassins  

Population > Effectif (TERMIUM Plus®)  

Post-Secondary Co-op / Internship Program > Programme postsecondaire 
d’enseignement coopératif de stages (Treasury Board of Canada Secretariat)  

Post-Secondary Recruitment program > Programme de recrutement postsecondaire  

Previous employment status > Situation professionnelle antérieure  

Priority Administration > Administration des priorités  

Priority clearance > Autorisation en matière de priorité (TERMIUM Plus® and Human 
Resources Management Glossary, Translation Bureau)  

Priority entitlement > Droit de priorité (TERMIUM Plus®)  

Priority entitlement consultant > Conseiller en droits de priorité 
 
Priority entitlement for appointment > Droit de priorité de nomination  

Priority Entitlement Program > Programme des droits de priorité  

Priority Information Management System > Système de gestion de l’information sur 
les priorités  

Priority Inventory > Répertoire des bénéficiaires de priorité 
  
Priority placement > Placement prioritaire (TERMIUM Plus®)  

Priority placement of medically released Canadian Forces members > Placement 
prioritaire des membres des Forces canadiennes libérés pour raisons médicales 
(TERMIUM Plus®)  

Priority system > Système des priorités  



Public Service Commission – 2019 Lexicon   

 
 

Privacy impact assessment > Évaluation des facteurs relatifs à la vie privée 
(TERMIUM Plus®) 

Privacy management framework > Cadre de gestion de la protection des 
renseignements personnels  

Probing questions > Questions d’approfondissement  

Procedural fairness > Équité procédurale (TERMIUM Plus®)  

Program Activity Architecture > Architecture des activités de programmes  
(Treasury Board of Canada Secretariat)  

Project Management Body of Knowledge® > Guide du Corpus des connaissances 
en management de projet® (TERMIUM Plus®) 

Promotion > Promotion  

Provincial election > Élection provinciale  

Provisions > Dispositions  

Public service > Fonction publique  

Public Service Employment Act > Loi sur l’emploi dans la fonction publique  

Public Service Employment Regulations > Règlement sur l’emploi dans la fonction 
publique  

Public Service Labour Relations and Employment Board > Commission des 
relations de travail et de l’emploi dans la fonction publique  
(Public Service Labour Relations and Employment Board Act)  

Public Service Official Languages Appointment Regulations > Règlement sur les 
langues officielles – nominations dans la fonction publique (Public Service Employment 
Act)  

Public Service Official Languages Exclusion Approval Order > Décret d’exemption 
concernant les langues officielles dans la fonction publique (Public Service Employment 
Act)  

Public Service Resourcing System > Système de ressourcement de la fonction 
publique  

Public service-wide pool > Bassin pour l’ensemble de la fonction publique  

Public service work experience > Expérience de travail à la fonction publique  
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Q 
Qualification standards > Normes de qualification (Public Service Employment Act)  

Qualifications > Qualifications (Public Service Employment Act) 

R 
Rate of movement > Taux de mobilité  

Rating > Notation (TERMIUM Plus®)  

Rating criteria > Critères de notation  

Reappointment > Renomination (TERMIUM Plus® and Employment Glossary, 
Translation Bureau)  

Record of decision > Rapport de décision (TERMIUM Plus®)  

Recruitment event > Salon de l’emploi  

Recruitment mechanism > Méthode de recrutement  

Recruitment of Policy Leaders (Initiative) > Recrutement de leaders en politiques 
(Initiative de)  

Referral (of candidates) > Présentation (de candidats)  
[TERMIUM Plus® and Employment Glossary, Translation Bureau]  

Regulatory priority > Priorité réglementaire (TERMIUM Plus®)  

Remedial action > Mesure de redressement  

Reporting requirements > Exigences en matière de rapport (TERMIUM Plus®)  

Representativeness > Représentativité (TERMIUM Plus®)  

Research Affiliate Program > Programme des adjoints de recherche (Treasury Board 
of Canada Secretariat)  

Resourcing > Ressourcement (TERMIUM Plus®)  
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Retraining > Formation d’appoint 

Review > Examen / revue  

Revocation > Révocation  

Rights and responsibilities > Droits et responsabilités  

Risk assessment > Évaluation du risque (TERMIUM Plus®)  

 

S 
Second Language Evaluation > Évaluation de langue seconde (TERMIUM Plus®)  

Secondment > Détachement (TERMIUM Plus®)  

Security Awareness Week > Semaine de la sensibilisation à la sécurité (Treasury 
Board of Canada Secretariat)  

Seek nomination (political activity) > Se porter candidat (activité politique) (Public 
Service Employment Act and TERMIUM Plus®)  

Selection decision > Décision de sélection  

Self-declaration > Autodéclaration (TERMIUM Plus®)  

Self-identification > Auto-identification (TERMIUM Plus®)  

Senior internal governance committee > Comité de gouvernance interne de la haute 
direction  

Senior management > Haute direction (TERMIUM Plus®)  

Separate agency > Organisme distinct (Public Service Employment Act and 
TERMIUM Plus®)  

Services and Business Development Sector > Secteur des services et du 
développement des affaires 

Simulations for the Selection of Executives > Simulations pour la sélection des EX 
(TERMIUM Plus®)  

Skilled > Qualifié (TERMIUM Plus® and Robert & Collins)  

Skills shortage area > Secteur en pénurie de main-d’œuvre (TERMIUM Plus®)  

Speed staffing > Dotation accélérée 
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Staffing activity > Activité de dotation (TERMIUM Plus® and Employment Glossary, 
Translation Bureau)  

Staffing advisor > Conseiller en dotation  

Staffing audit tool > Outil de vérification en matière de dotation  

Staffing file > Dossier de dotation  

Staffing letter builder tool > Outil de rédaction de lettres pour la dotation  

Staffing result > Résultat de dotation (TERMIUM Plus®) 

Staffing risk > Risque en matière de dotation (TERMIUM Plus®)  

Staffing-related employment equity initiative > Initiative d’équité en matière d’emploi 
relative à la dotation  

Staffing support advisor > Conseiller au soutien en dotation  

Stakeholder > Intervenant (TERMIUM Plus®)  

Statement of Merit Criteria > Énoncé des critères de mérite  

Statistical study > Étude statistique (TERMIUM Plus®)  

Statutory and regulatory priority > Priorité statutaire et réglementaire  
(Treasury Board of Canada Secretariat)  

Statutory basis > Fondement législatif  

Statutory instrument > Texte réglementaire (TERMIUM Plus®)  

Statutory priority > Priorité statutaire (Treasury Board of Canada Secretariat)  

Statutory priority entitlement > Droit de priorité statutaire (Treasury Board of Canada 
Secretariat)  

Student employment program > Programme d’emploi pour étudiants  
(TERMIUM Plus® and Treasury Board of Canada Secretariat)  

Student Employment Programs Participants Exclusion Approval Order > Décret 
d’exemption concernant les participants aux programmes d’embauche d’étudiants 
(Public Service Employment Act and TERMIUM Plus®)  

Student Employment Programs Participants Regulations > Règlement sur les 
participants aux programmes d’embauche d’étudiants (Public Service Employment Act 
and TERMIUM Plus®)  

Student hires / hiring > Embauche d’étudiants  
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Sub-delegated manager > Gestionnaire subdélégué (TERMIUM Plus® and the Human 
Resources Management Glossary, Translation Bureau)  

Sub-delegated official > Représentant subdélégué (TERMIUM Plus®)  

Sub-delegated position > Poste comprenant des pouvoirs subdélégués  

Substantive position > Poste d’attache (TERMIUM Plus®)  

Super user > Superutilisateur (Oxford Dictionary and Dictionnaire d’Internet, de 
l’informatique et des télécommunications)  

Surplus employee > Fonctionnaire excédentaire  

Survey of Staffing – Candidates > Sondage sur la dotation – Candidats  
(TERMIUM Plus®and Statistics Canada)  

Survey of Staffing – Managers > Sondage sur la dotation – Gestionnaires  
(TERMIUM Plus®and Statistics Canada)  

Suspicion of political influence > Influence politique présumée (TERMIUM Plus®)  

T 
Talent sourcing > Recherche de talents  

Technical or specialized language skill – Code P > Compétence linguistique 
technique ou spécialisée – Cote P  

Telecommunications device for the deaf > Appareil de télécommunication pour 
sourds  

Teletype > Télétype   

Tenure > Durée d’emploi  

Terms and conditions > Modalités  

Term employment > Emploi de durée déterminée  

Term hiring > Embauche de durée déterminée  

Term or indeterminate appointment > Nomination de durée déterminée ou   
indéterminée  

Terms of access > Modalités d’accès  
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Territorial election > Élection territoriale  

Test of oral proficiency in the second official language > Test de compétence orale 
dans la seconde langue officielle  

Test scoring and results reporting > Système de correction des examens et de 
production des rapports (TERMIUM Plus®)  

Timely correction > Correction en temps opportun  

Time to staff > Durée du processus de dotation  

Top performing organizations > Organisations les plus performantes  

Transition guide > Guide sur la transition  

Transparency > Transparence 

Type and tenure (employment) > Type et durée d’emploi 

U 
Unfounded allegation > Allégation non fondée (TERMIUM Plus®)  

Unfounded complaint > Plainte non fondée (TERMIUM Plus®)  

Universal Test Design > Conception universelle des examens  

Unsupervised Internet Testing > Test en ligne non supervisé  

V 
Values-based staffing system > Système de dotation fondé sur des valeurs 
(TERMIUM Plus®)  

Variance analysis > Analyse des écarts  

Veterans Hiring Act > Loi sur l’embauche des anciens combattants (Justice Canada)  
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W 
Weakness > Lacune / point faible  

Web analytics > Analyse web 

Workforce > Effectif (TERMIUM Plus®)  

Workforce availability > Disponibilité au sein de la population active  

Written narrative assessment > Évaluation narrative écrite  
(Statistics Canada, Survey of Staffing Glossary) 


